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Getting Started
The SuperBar program is a Windows program for creating and editing user configurable    
tool bars called    SuperBars.    A SuperBar consists of a gray area containing several buttons, 
each assigned to an application menu command.    A SuperBar can be added to any Windows
application that is compatible with the SuperBar program.    

The following steps demonstrate how to add a SuperBar to the Windows Program Manager.

1) Run the SuperBar program.
2) Select  Program Manager from the Application list.
3) Select SuperBar from the Application    menu to add a new SuperBar to the 

application.
4) Select SuperBar from the Application menu to add a blank SuperBar.
5) Select Edit... from the Application menu.    The SuperBar Properties dialog will be 

displayed.
6) Select the Show Bar option to cause the SuperBar to be created every time the 

application is executed.
7) Click the Layout... button.    The SuperBar Layout dialog will be displayed.
8) Select File|Exit Windows... from the Available Menu Commands list. 
9) Click the Add button.    The menu command will be placed in the Current SuperBar 

Layout list..    A stop sign    icon and 'Exit' caption will automatically be selected.
10) Click the Ok button.    The SuperBar Layout dialog will close.
11) Click the Ok button.    The SuperBar Properties dialog will close.
12) Select Program Manager from the application list.
13) Select Switch from the Application button.    This will switch to the Windows 

Program Manager.    The application will have a SuperBar along the top of the window 
with a single Exit button. 

You can now use this button to exit Windows.    To edit the SuperBar, double-click on the gray
area to the right of the button to display the SuperBar Properties dialog.    Click the Help 
button on this dialog for further information on editing the SuperBar.



Using the SuperBar Program
The SuperBar program main window consists of an application list and several action 
buttons.    These options allow complete control over adding, removing and editing 
SuperBars. 

Application List
The application list shows all Windows applications which are currently executing.    
You must run the desired application before it will be displayed in the application list 
and before you can add or modify its SuperBar.    Each entry in the list contains the 
following two flags and the application name. 

H indicates that the application is currently hidden.
S indicates that the application currently has an active SuperBar.

To edit the application's properties or SuperBar layout, select the application and use 
the Edit command of the Application menu.    

Double-clicking on an application in the list    can perform one of four actions.    The 
actions include Switch, Edit, Close and Hide.    Use the Preferences dialog box to set 
the desired double-click action.



Using a SuperBar on an Application
Once a SuperBar has been added to an application, using it is very straight forward.

Invoking a Menu Command
To invoke a menu command, simply click on the assigned button.    After the button is 
clicked, the menu command will be sent to the application.

Editing a SuperBar
To edit a SuperBar directly from its application, double-click on the gray background 
of the SuperBar.    This will open the SuperBar Properties dialog box to edit the 
SuperBar.



Running SuperBar when Windows Starts Up
The SuperBar program works best when it is loaded as part of Windows start up.    To 
automatically load SuperBar, perform the following steps depending on which version of 
Windows is used.

Note:    The following steps assume that Windows is located in the C:\WINDOWS    directory 
and SuperBar is located in the C:\SUPERBAR    directory.    If they are located elsewhere, 
change the steps accordingly.

Windows 3.0

To automatically load SuperBar, the Windows    WIN.INI  file must be modified.    The 
following steps show how to make this change.    

1) Run the Windows Notepad editor and open the file C:\WINDOWS\WIN.INI
2) Near the top of the file will be the following line:

Load=
If other programs are being automatically loaded, the line may be similar to the 
following:

Load=C:\DIR\PRG.EXE
This line consists of a list of Windows applications to be loaded each time Windows is 
started.    Each application in the list is separated by a space.

3) The SuperBar program must be added to the beginning of this line.    Change this line 
to resemble the following:

Load=C:\SUPERBAR\SUPERBAR.EXE
or

Load=C:\SUPERBAR\SUPERBAR.EXE C:\DIR\PRG.EXE
4) Exit and restart Windows.    

Windows 3.1

To automatically load SuperBar, perform the following steps:

1) Open the StartUp group in the Program Manager.
2) Select the New... command from the File menu.
3) Select Program Item and click the Ok button.
4) Enter SuperBar in the Description edit box and c:\superbar\superbar.exe in the 

Command Line edit box.    Click the Ok button.

See the Windows User's Guide for more information on using the StartUp group.

All Versions

After completing these steps, the SuperBar program will automatically be loaded each time 
Windows is executed.    The SuperBar program will appear as an icon near the bottom of the 
desktop    (you may need to resize the Program Manager to see this icon).    After the 
SuperBar program is loaded, any applications with the Show Bar option of the SuperBar 
Properties dialog box will display a SuperBar whenever they are executed.





File Menu
The File menu includes commands for setting SuperBar preferences, running the SuperBar 
Icon Manager and exiting SuperBar or Windows.

For more information, select one of the following menu commands.

Preferences... Opens the Preferences dialog box.

Run Icon Manager... Runs the SuperBar Icon Manager for creating user-defined icons.

Exit Windows... Exits Windows.

Exit Exits the SuperBar program.



Application Menu
The Application menu includes commands that allow adding, editing and removing of 
SuperBars.

For more information, select one of the following menu commands.

SuperBar Adds or removes a SuperBar from the selected application.
Hide Hides or restores an application window.

Switch to Switches to the selected application.
Close Closes the selected application.
Edit Edits the SuperBar of the selected application.

Add all Adds a SuperBar to all applications.
Remove all Removes SuperBars from all applications.



Desktop Menu
The Desktop menu includes commands that affect all windows on the desktop.

For more information, select one of the following menu commands.

Cascade Rearranges the windows so that they overlap with each title bar
visible.

Tile Rearranges the windows to smaller sizes to fit on the desktop 
without overlapping.

Arrange Icons Rearranges all icons evenly across the bottom of the desktop.

Minimize All Shrinks all windows to icons.
Initial Positions Rearranges all windows to their initial positions as defined in the

SuperBar Properties dialog.



Help Menu
The Help menu includes commands for accessing on-line help.

For more information, select one of the following menu commands.

Index Displays the index to the on-line help.
About Displays information on this version of SuperBar.



Preferences command (File menu)
This command opens the Preferences dialog box.    It allows selection of different options for 
operating SuperBar.    It includes options for hiding the SuperBar icon and displaying different
information in the application list.



Run Icon Manager command (File menu)
This command runs the SuperBar Icon Manager.    This program allow creating, editing 
and deleting user-defined icons.    For further help on this program, select this menu 
command to execute it and press F1 for complete on-line help.



Exit Windows command (File menu)
This command exits Windows.    If the Quick Exit Windows option in the Preferences dialog 
box is selected, Windows will immediately terminate.    If the option is not selected, a dialog 
box prompt will first be displayed.



Exit command (File menu)
This command terminates the SuperBar program.    Any active SuperBars will be removed 
from currently executing application.    Before exiting, close any SuperBar Properties or 
SuperBar Layout dialog boxes.



SuperBar command (Application menu)
This command adds or removes a SuperBar from the selected application.    If no SuperBar 
has been previously defined, an empty SuperBar will be created.    This menu option is only 
enabled for applications that have menus.



Hide command (Application menu)
This command hides or restores an application's window.    A hidden application is an 
application which is running but is not displayed on the desktop.    Hiding an application 
helps to free space on the desktop.    Selecting this menu command a second time restore 
the application and displays it on the desktop again.



Switch To command (Application menu)
This command switches to the selected application.



Close command (Application menu)
This command closes an application.    A close window command is sent to the application 
requesting the application to terminate.    This command can be used to exit an application 
without needing to find it on the desktop.



Edit command (Application menu)
This command opens the SuperBar Properties dialog box to begin editing of the selected 
application's SuperBar.



Add All command (Application menu)
This command adds SuperBars to all applications which currently do not have a SuperBar.    
Any applications which do not have previously defined SuperBars will have empty SuperBars
created.



Remove All command (Application menu)
This command removes SuperBars from all applications which currently have them.



Cascade command (Desktop menu)
This command rearranges all windows on the desktop so that they overlap with each title 
bar visible.



Tile command (Desktop menu)
This command rearranges all windows on the desktop to smaller sizes to fit on the desktop 
without overlapping.



Arrange Icons command (Desktop menu)
This command rearranges all icons evenly across the bottom of the desktop.    Only windows 
shrunk to icons are affected.



Minimize All command (Desktop menu)
This command shrinks all windows to icons.    Only windows with Minimize buttons are 
affected.



Initial Positions (Desktop menu)
This command rearranges all windows to their initial positions on the desktop as defined in 
the SuperBar Properties dialog box.    Only windows with the Position option checked are 
affected.



Contents command (Help menu)
This command displays the index of the SuperBar on-line help. From the index, you can jump
to information on General Topics, Menu Commands or Defined Terms.



About SuperBar command (Help menu)
This command displays the About dialog box.    



About Dialog
This dialog box displays information on this version of SuperBar.    It displays the version 
number of the program.    In addition, if the program is registered, a customer number will be
displayed.    

Dialog Options

Register
Opens the Register dialog box. for entering the Registration Code.

Ok
Closes the dialog box.



Register Dialog
This dialog box is used to enter the Registration Code.    When the program is registered, the 
About SuperBar dialog box will no longer be displayed when the program is executed. 

Dialog Options

Registration Code
Enter the Registration Code in this box.

Ok
Validates the Registration Code.    If the code is valid, the dialog box will close and a 
Customer Number will be displayed on the About dialog box.    A message will be 
displayed if the code is invalid.    Close the message box to enter the Registration 
Code again.

Cancel
Close the dialog box.    The SuperBar program will remain unregistered.

 



SuperBar Properties Dialog
This dialog box is used to set the properties of a SuperBar.    It allows setting the contents, 
style, location and options of the SuperBar.

Dialog Box Options

Style
Selects one of three button styles.    They include Icon Only, Caption Only and Icon 
with Caption.    The caption styles can be used to become familiar with the icons.

Bar Location
Selects the location of the SuperBar.    The SuperBar can be located along the Top, 
Bottom, Left or Right edge of the application's window.

Options
Show Bar This option causes a SuperBar to appear on the selected application 

whenever it is executed.    See also Running SuperBar when Windows 
Starts Up.

Position This option causes the selected application to always be executed at 
the same location on the desktop.    See Window Initial Position 
below for instructions on setting the initial position.

Window Initial Position
Normal Execute the application where it was located the last time the Current

Pos button was clicked.
Max Execute the application maximized (full screen).
Icon Execute the application as an icon.
Hidden Execute the application as a hidden window.    The program will run but 

will not occupy any desktop space.

Ok
Save all changes and close the dialog box.

Layout...
Edits the SuperBar    Clicking this button opens the SuperBar Layout dialog box.

Help
Displays this help information.



SuperBar Layout Dialog
This dialog is used to edit the layout of a SuperBar.    It allows setting the menu command, 
icon and caption for each button.

Dialog Box Options

Available Menu Commands
Lists all menu commands available to the application.    It only lists the menu 
commands currently assigned to the menu.    Many applications frequently change 
the layout of the menu.    To select a menu command it must be available on the 
menu before opening this dialog box.    The list also consists of the following special 
purpose buttons:

<Space> A blank space the size of a button.    This can be used to group related 
buttons together on the SuperBar.

<HalfSpace> A blank space half the size of a button.

<Wrap> Forces the next button to occur be placed in a new row/column.

<System> Commands beginning with <System> represent menu commands from
the System menu.

Current SuperBar Layout
Lists the menu commands currently attached to buttons on the SuperBar.    Select an 
entry from this list to allow editing, inserting or removing buttons on the SuperBar.    
The list only contains the names of menu commands currently assigned to the 
menu.    If a button is assigned to a menu command not currently available, it will be 
displayed in the form:    [Unknown - ###] where ### is a unique identifier 
assigned to each menu command.

Icon
Selects the icon to be displayed on the button.    Several general and special purpose 
icons are available.    Large character icons are also available if a predefined icon 
cannot be found.

Caption
Selects the caption to be displayed on the button.    The caption must fit in this box to
fit on the button.

Add
Adds the selected menu command to the end of the SuperBar.

Insert
Inserts the selected menu command before the selected SuperBar button.

Change
Changes the selected SuperBar button to the selected menu command.

Remove
Removes the selected SuperBar button.

Ok
Accepts all changes and closes the dialog box.



Help
Displays this help information.



Preferences Dialog
This dialog box is used to select options for the SuperBar program.    It includes several 
options for customizing the SuperBar program.

Dialog Box Options

Hide Icon
Never Never hide icon.
After 10 Seconds Hide icon after 10 seconds.
Always Always hide icon.

Options
View File Names Show executable (.EXE) file name and window class name in the

application list.    This information forms the unique 
identification used to distinguish different application windows.

Quick Exit Windows If this option is selected, the Exit Windows... command from 
the File menu will immediately exit Windows without any 
prompting.

Cache
Size Defines the size of the SuperBar button cache.    To improve drawing 

SuperBars, the images of recently used button icons are stored in 
memory.    This option sets the number of icons to store.    The value 
following this entry indicates the size of the cache in kilobytes.    The 
Hit and Miss values indicate the number of icons read from memory 
and read from disk respectively.    These counts are reset whenever the 
cache size is changed.    If Windows is running low on memory, this 
value can be lowered.    If the Miss count is large, this value can be 
raised to improve SuperBar drawing speed.

Double Click
Switch Switches to the selected application when double clicking on the 

Application List.

Edit Opens the SuperBar Properties dialog box for the selected application 
when double clicking on the Application List.

Close Terminates the selected application when double clicking on the 
Application List.

Hide Hides the selected application when double clicking on the 
Application List.

Ok
Accepts all changes and closes the dialog box.

Cancel
Ignores all changes and closes the dialog box.

Help
Displays this help information.



New Version Dialog
This dialog box is automatically displayed the first time SuperBar version 1.1 or higher is 
executed if a version 1.0 initialization file is found.    It explains how to update from version 
1.0 to the new version.

This update procedure is necessary because the version 1.0 initialization file has some 
incompatibilities which cannot be updated until each application is executed.

Dialog Box Options

Ok
Closes the dialog box.

Help
Displays this help information.



Update Dialog
This dialog box is automatically displayed the first time a SuperBar is edited under version 
1.1 or higher if a version 1.0 layout is found.    It presents the options for updating the 
version 1.0 layout to the new format.

Dialog Box Options

Update
Converts the version 1.0 layout to the new format and closes the dialog box.

Delete
Deletes the version 1.0 layout, creates an empty layout and closes the dialog box.

Help
Displays this help information.



Exit Windows Dialog Box
This dialog box is displayed whenever the Exit Windows command is selected and the Quick
Exit Windows option is not selected in the Preferences dialog box.

Dialog Box Options

Ok
Exits Windows.

Cancel
Closes dialog box and returns to Windows.



Definitions
-A-

application

-B-

button

-C-

caption

-D-

desktop

-I-

icon

-M-

menu command

-R-

Registration Code

-S-

SuperBar



Menu Command
The term menu command refers to any item of an application's menu that sends a command
to the application.    Any menu command can be assigned to a button.



Registration Code
The term Registration Code refers to the code which will be sent to registered users after 
sending in the registration fee.    The code must be typed into the Registration dialog box.    
The code can be typed in either upper or lower case.    Refer to the About dialog box or the 
other documentation included with this program for information on registering this program.



Application

The term application refers to a Microsoft Windows application which is compatible with 
SuperBar.    To be compatible with SuperBar, the application must have a standard Windows 
Menu Bar.



Button

The term button refers to a single button on a SuperBar.    Each SuperBar can contain up to 
50 buttons.    Each button corresponds to an application's menu command.    Clicking on a 
button sends the corresponding menu command to the application.



Caption

The term caption refers to the caption text displayed on a button.    The caption is user 
configurable.    The caption is only displayed on certain button styles.



Desktop

The term desktop refers to the screen background for Windows.    Each Windows application 
executes in a window on top of the desktop.



Icon

The term icon refers to the graphical picture displayed on a button.    The icon is selected 
from a list of predefined graphic and character icons.    The icon is only displayed on certain 
button styles.



SuperBar

The term SuperBar refers either to the SuperBar program itself, or the actual bar located on 
the application.    A SuperBar is a gray bar containing several buttons, each assigned to an 
application menu command.    Clicking on a button invokes the corresponding command.    
Double-clicking on the gray background of the bar allows editing of the SuperBar.


